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SpaceClaim 2011+ Enhancements Overview  

SpaceClaim 2011+ provides product enhancements driven by customer feedback to continue 
{ǇŀŎŜ/ƭŀƛƳΩǎ ŎƻǊŜ ƳƻŘŜƭƛƴƎ ŜȄŎŜƭƭŜƴŎŜ ŀƴŘ ŜȄǘŜƴŘ its strengths in sheet metal design and drawing 
creation. SpaceClaim 2011+ ς ǘƘŜ /ƻƳǇŀƴȅΩǎ ŜƛƎƘǘƘ ǊŜƭŜŀǎŜ ƻŦ ƛǘǎ ǎƻŦǘǿŀǊŜ ς builds on features that 
enable engineers to leverage 3D for concept modeling, bid modeling, and model preparation for 
manufacturing and analysis. 
 

Modeling  
¶ Pattern tools (linear, rotational and fill pattern) w/ new UI 

¶ STL as solid import 

¶ STL cross-section curve fitting 

¶ Clipping planes and clipping regions 

¶ Standard Hole creation 

¶ Move drag in plane 

¶ Multi-threaded faceting (increases modeling speed with more cores) 

¶ Sketch dimensioning improvements 

¶ Measure minimum distances 

Model Preparation for CAE  
¶ Improved Volume Extract with leak preview and shrink wrap 

¶ Improved Missing Face repair (multiple patches & automatic tangent add) 

¶ Improved Merge Faces (neighboring edge cleanup) 

¶ New Duplicates tool removes duplicate surface/solid geometry 

Ease of Use 
¶ Selection: by color, body type, parent, instance, and polygon 

¶ View manipulation: improved Spin and Plan View 

¶ Import user settings 

¶ New interactive view orientation gizmo on screen 

¶ Align sketch grid with secondary selection 

Sheet Metal 
¶ Double walls 

¶ Tabs/Hinges 

¶ Gusset Creation 

¶ Markers 

¶ Improved unfolding 

¶ K-factor type 

¶ Stroke font support 

¶ Mirrored parts 

¶ Wrap curves from unfold 

Documentation  
¶ Offset cross-sections 

¶ Hole tables 
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¶ Bolt hole circles 

¶ Datum targets 

¶ External model drawing views 

¶ Print to PDF  

¶ Circular and mirrored text 

File Operations  
¶ Backup Assistant for recovering files 

¶ Send for sharing assemblies with external references 

¶ Import JT PMI 

¶ CATIA point import/export 

¶ JTOpen export configuration files 

¶ ProE assembly cuts  

¶ Dwg polyface mesh color and layer import 

¶ 5ȄŦκŘǿƎ ƻǳǘΥ άǎŎŀƭŜ ƻǳǘǇǳǘ мΥмέ ƻǇǘƛƻƴ 

¶ Exclude drawing format on dxf/dwg out 

Partners  
¶ Improved KeyShot integration (shared material library, lightweight model transfer) 
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General 
 
There is now an option on the mini toolbar that enables you to modify the color of edges, faces and 
bodies when selecting an object. 
 
After installing KeyshotϰǾнΦн, each SpaceClaim startup automatically retrieves installed Keyshot 
materials. This feature consistently provides the user with the most recent rendering materials available. 
To get all available materials and preview images, made sure to refresh materials with Keyshot. 
 

wŜƴŘŜǊƛƴƎ ǿƛǘƘ YŜȅǎƘƻǘϰ Ŏŀƴ ƴƻǿ ōŜ ǇŜǊŦƻǊƳŜŘ ƻƴ ƭƛƎƘǘǿŜƛƎƘǘ ŀǎǎŜƳōƭȅ ŎƻƳǇƻƴŜƴǘǎΦ [ƛƎƘǘǿŜƛƎƘǘ 
components are a graphics-only representatioƴ ƻŦ ŀ ŘŜǎƛƎƴΤ ƻƴƭȅ ǘƘŜ ŎƻƳǇƻƴŜƴǘΩǎ ƎǊŀǇƘƛŎŀƭ ƛƴŦƻǊƳŀǘƛƻƴ 
is loaded.  Rendering designs with lightweight components reduces CPU memory and file size, which 
enhances SpaceClaim speed and performance. 
 
There is now an All checkbox option in the Selection Filter drop-down in the status bar. This enables the 
user to select all available filters with a single-click. Previously, all Filter checklists were selected by 
ŘŜŦŀǳƭǘ ŀƴŘ ǘƘŜ ǳǎŜǊ ǿƻǳƭŘ ƘŀǾŜ ǘƻ ƛƴŘƛǾƛŘǳŀƭƭȅ ŘŜǎŜƭŜŎǘ ŜŀŎƘ ǳƴǿŀƴǘŜŘ ŦƛƭǘŜǊΩǎ ŎƘŜŎƪōƻȄΦ  
 
There is now a label in the status bar that displays the currently preselected object. In the status bar, this 
label is located to the left of the selected object status information. Previously, only the label of the 
selected object was displayed in the status bar. 
 
You can now lock the base dimension base point when sketching multiple objects.  Locking a base 
dimension base point enables you to secure the dimensions of an object relative to that point, or, the 
dimensions of an object relative to any object you sketched previously. As you sketch, you can enter 
coordinates for each successive point relative to the previous point. Previously, you could only use a 
locked point once; now, with base dimension base point locked, it is not necessary to re-set the base 
point for each and every entity. 
To lock a base dimension base point: 

1. Enter Sketch mode. 

2. Select the Cartesian dimensions option from the Sketch options panel. 

3. Select the Lock base point dimensions checkbox in the Sketch options panel. 

4. Place the sketch on the sketch grid relative to your chosen dimensions from the locked base 
dimension base point. 

 
 
To change the location of a base dimension base point: 

1. While in Sketch mode, while hovering over the base dimension base point from which you want 
to take a dimension, press Shift to dimension between the selected object and that point. The 
Cartesian dimensions are now taken from this new base dimension base point.  

 
 
In the Control options section of the Popular options menu, you can now opt to 
select the Show view orientation in design window checkbox. When ON it displays 
a view orientation gizmo in the design window, as shown to the right. You can 
click a linear gizmo arrow to rotate the design to a new orientation in 3D, or a 
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rotational arrow to rotate the design in 90-degree increments in the plane of the screen (same behavior 
as the Rotate function in the ribbon group). 
 
When hovering over a menu-chosen Named view, the tooltip now displays a picture of the orientation 
of that view. This enables the user to visualize and verify the intended orientation before actually 
selecting the view. The user is no longer required to guess which view will display.  
 

You can now right-click on a lightweight object in the design window and select Load Component from 
the context menu. Selecting Load Component loads the component and all its subcomponents' 
geometry information. Once loaded, you can then use any tool to modify the components. Previously, 
you could right-click the component only in the Structure tree, and then select Load Component from 
the context menu. 

 
In the Advanced screen in SpaceClaim Options, you can now click Import User Settings to import user 
settings. This feature enables you to apply non-default, customized selections that are unique to an 
individual user.  

To import user settings 

1. Select SpaceClaim Options from the Application menu then click Advanced. 

2. Click Import User Settings. 

The Open dialog box displays.  
A valid SpaceClaim user.config  file (XML format) must be available for import. 
User.config  file location can vary depending on SpaceClaim installation, but generally, this 
file type is stored in your local AppData directory. 

3. Locate the user.config  file you want to import, or, enter the name of the user.config  file in 

the File Name text box. 

4. Click Open. 

5. Click OK to close the SpaceClaim Options window. 

 
¢ƘŜǊŜ ƛǎ ƴƻǿ ŀ ƴŜǿ ŎƻƴǘŜȄǘ ƳŜƴǳ ŎƻƳƳŀƴŘ ƛƴ ǘƘŜ 5ŜǎƛƎƴ ǿƛƴŘƻǿ ƴŀƳŜŘ ά/ƭƛǇ ±ƻƭǳƳŜέΦ !ǎ ȅƻǳ 
develop a model, Clip Volume enables you to create a spherical clip volume around an object so that you 
can selectively isolate a specific region, element, or section of a design. Using ClipView can be 
particularly helpful when you need to closely view and work on a specific feature of interest within a 
complex model. For example, after using ClipView to isolate a design area, you can use the Repair > 
Missing Faces tool to help detect and fix missing faces on a body. 
 

To set ClipView options 

1. Select SpaceClaim Options from the Application menu then click Navigation. 

2. Select an option in the ClipView group: 

¶ Preview color: Sets the preview color of the sphere representing your selected ClipView. 

¶ Clip selection: Trims the visible and selected surfaces inside a Clip Volume by the Clip 
Volume boundary. If you select this option, you are working in Clip Selection mode, and you 
can toggle Clip selection and Zoom to fit from the Misc section of the Properties panel. If 
you do not select this option, you are working in Clip Interactive mode. In this mode, you 

ms-its:C:/SPACEC~3/SPACEC~1.CHM::/The_SpaceClaim_interface.htm
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cannot modify options from the Misc section of the Properties panel. When you select a 
face within the boundary, the entire face (unclipped) displays.  

3. Select your options and then click OK to close the SpaceClaim window. 

 

 

To use ClipView in Clip Selection mode 

1. Rotate and zoom in to your model to locate the model element or area you want to view. 

2. With nothing selected, right mouse click and select Clip View > Set.  

3. Hover over the center of the element you want to view and click+drag to create your spherical 

clip volume. 

  
 
4. Release the mouse. The area you selected to preview magnifies and displays as clipped, or 

isolated, from the rest of the model.  

  
 
 To re-display your design with no clipping, right mouse click and select Clip View > Clear. 

 
¢ƘŜǊŜ ƛǎ ƴƻǿ ŀƴ ƻǇǘƛƻƴ ƛƴ ǘƘŜ ƎŜƴŜǊŀƭ ǎŜŎǘƛƻƴ ƻŦ ǘƘŜ aǳƭǘƛǘƻǳŎƘ ƻǇǘƛƻƴǎ Ψ{ŜƭŜŎǘ ŜŘƎŜ ƭƻƻǇǎ ǳǎƛƴƎ ǘƻǳŎƘ 
ƎŜǎǘǳǊŜǎ ƻǊ ƳƻǳǎŜ ǎŎǊƻƭƭ ǿƘŜŜƭΩΦ ¢Ƙƛǎ ƻǇǘƛƻƴΣ ŎƘŜŎƪŜŘ ƻƴ ōȅ ŘŜŦŀǳƭǘΣ ŀƭƭƻǿǎ ȅƻǳ ǘƻ ǉǳŜǊȅ ǎŜƭŜŎǘ ǘƘǊƻǳƎƘ 
edge loops and use touch gestures to also query select through edge loops. This new multitouch option 
will override the same option in the Advanced> Selection section of the option panel, which is checked 
off by default. These two options are now independent of one another.  

 
In the Structure tree, you can uncheck the box next to an object to hide it in the Design window. This 
action now executes nine (9) times faster than previously. 
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There is a new option on the STL file options screen in the File Options group of SpaceClaim Options.  
You can select the Override model units checkbox to remove default settings for the number of model 
units in an imported STL file. You can also de-select the Check Geometry button, which, when enabled, 
ŎƘŜŎƪǎ ŀ ƳƻŘŜƭΩǎ ǎƻƭƛŘǎ ŀƴŘ ǎǳǊŦŀŎŜǎ ŦƻǊ !/L{ ŜǊǊƻǊǎΦ 

 

A new Facet maximum edge length checkbox now displays in the Export section of both the STL file 
options screen and the OBJ file options screen in the File Options group of SpaceClaim Options. To set 
the maximum length for edges, select the checkbox and enter the desired edge length. The value you 
specify is the maximum value for the edges, however smaller edge lengths may be created. The ACIS 
modeler will try to meet your desired edge length setting, but in some design scenarios, may create an 
edge length that is less than your setting, to best accommodate the design. Previously, edge length was 
not settable. 

 
In the General group in the Advanced screen in SpaceClaim Options, you can select the Backup every 
checkbox to enable the new recovery assistant feature. With recovery assistant, you can save your files 
automatically, helping to reduce the risk or impact of data loss in case of a crash or freeze. The default 
backup time interval is 10 minutes, but you can select a time interval from 1 to 100 minutes. Once you 
select a time interval, you can enter or click the   Browse button to select a location for the backup files 
on your computer. If you save your file before your session ends, your backup files are purged. 

 
There is now a Clear Backup Files button in the General group in Advanced SpaceClaim Options. This 
allows you to manually purge all backup files from your backup file location at your convenience. 

 
Now, when you launch SpaceClaim after an application crash, an Information box displays to notify you 
that backed up files are available. To recover backup files, click Restore from the Application menu, then 
select the file you want to open. During your SpaceClaim session, up until you begin working with a 

model, you can also mouse over the  Information icon to display the Information box, as shown 
below: 
 

  
 

There is a new user setting in the General group in Advanced SpaceClaim Options. Use the Keep backup 
files for ̂  days scroll window to select the number of days (0-100) that you want to store your backup 
files.  By default, SpaceClaim sets the number of days at 7.  

 

When you select a component in the Structure tree and right-click to select Convert to External, you 
place a file on disk as a representative of an external document. The Properties panel updates to display 
ŘŜǘŀƛƭǎ ƛƴ ǘƘŜ ŎƻƳǇƻƴŜƴǘΩǎ bŀƳŜ ǎŜŎǘƛƻƴΦ  ²ƛǘƘ ŜȄǘŜǊƴŀƭ ŎƻƳǇƻƴŜƴǘǎΣ {ǇŀŎŜ/ƭŀƛƳ ƴƻǿ ŀƭǎƻ ŎǊŜŀǘŜǎ ŀ 
ΨǘƘǳƳōƴŀƛƭΩ ƛƳŀƎŜ ƻŦ ŀ ƴŜǿ ŜȄǘŜǊƴŀƭ ŎƻƳǇƻƴŜƴǘΩǎ ΦǎŎŘƻŎ Ŧile. This thumbnail image helps you identify 
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the file before you insert it or perform some other file action. Previously, thumbnail images did not 
display for external documents.  

 
There is a new checkbox in the Send dialog box. You can now select the Create ZIP file checkbox to 
compress a model that you want to archive. When you archive a model, it stores the .scdoc file and the 
.zip file in a file folder named with the file naming convention <model name>_archive. This feature 
allows for improved file organization and use of file storage space. 

 
You can now single click to highlight an entire text string (across columns) in a Properties panel cell. This 
usability enhancement eliminates the need to backspace through other text in the cell, for example, 
wheƴ ǘƘŜ ǾŀƭǳŜ ƛǎ άмƳƳέΣ ƛƴ ƻǊŘŜǊ ǘƻ ƳƻǊŜ ǉǳƛŎƪƭȅ ŀƴŘ Ŝŀǎƛƭȅ ǊŜŀŎƘ ǘƘŜ ǾŀƭǳŜ ŜƴǘǊȅ ȅƻǳ ǿŀƴǘ ǘƻ ŎƘŀƴƎŜΦ 

 
The color of the Progress bar, which displays in the Status bar to the 
right of the Selection Filter tool, has changed to a blue gradient, as 
shown in the image to the right:  
  
When you import or save a file, the Progress Indicator,  which also 
displays now in blue, shows the progress of the file as a whole (0-
100%), as shown in the image to the right. Previously, the indicator 
displayed progress for each individual file.  
 

 
 

 
The Orient group now displays on the Measure tab. Previously, the Orient group displayed on all other 
tabs except the Measure tab. 
 

Text has been removed for some tool icons from both the Insert group on the Design tab and the Orient 
group on all tabs in order to save space on the Ribbon, as shown in the image below:

 
 

When you import an AutoCAD (.dwg) polyface mesh model with the option Solid Models (in the Import 
section of the AutoCAD file options screen settings) turned on, the color and layer of the model are now 
preserved.  Previously, even though the Solid Models option was selected, SpaceClaim sometimes did 
not import the file as a solid, and in no case were color and layer settings being used.  The image set 
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below shows an example of how this model type imported previously, and the same model imported as 
a solid, with color and layer intact.  
 

 
 

 

 

The Sketch group now includes the Face Curve button, as shown below: 
 

 
 
The Show popup messages in status bar checkbox is ON by default, and when enabled,  displays pop up 
messages in the status bar area. These messages provide hints and feedback while you work in 
SpaceClaim. Deselect the checkbox to turn off the popup message display. 

 
5ƻŎǳƳŜƴǘ ǘŀōǎ ƴƻǿ ƛƴŎƭǳŘŜ ŀƴ ΨȄΩ ό/ƭƻǎŜύ ōǳǘǘƻƴ ŀŦǘŜǊ ǘƘŜ ŘŜǎƛƎƴ ƻǊ ŘǊŀǿƛƴƎ ǎƘŜŜǘ ƴŀƳŜΣ ŀǎ ǎƘƻǿƴ ƛƴ 
the image to the right. The button, and a thumbnail of your design, display when you hover over the 
name. A Save prompt displays if you have made changes to your design; select Yes to save your changes 
and close the design, No to discard your changes and close the design, or Cancel to stop the close 
process and return to your design.  
 

 
 

 
To save ribbon space, the Highlight options in the Show group on the Sheet Metal tab now display as a 
dropdown, as shown in the image below:  
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Two new rotation controls have been added to the Spin tool in the Orient 
group on the Design tab: Rotate 90 Clockwise and Rotate 90 Counterclockwise, 
as shown in the image to the right. These controls are provided in addition to 
the on-screen view gizmo control, and can be used whether your spin is set to 
On Center or On Cursor. Click either of the new controls once or multiple times 
to orient your design as needed for optimal viewing. Previously, these controls 
displayed in the Orient group on the Display tab. 

 
The Video Help (F3) tooltips feature, as shown in the Pull tooltip in the image to the right, is ON by 
default. Over 60 animated .gif files for F3 tool tips are 
now currently enabled.  
 
 
 
 

 

 

 

 

 

 

 

There is now an option to Power Select faces with the same color.  

 

How to Power Select faces with the same color: 

1. Open a model with different colors on multiple faces of the model. 
2. Select a face of a particular color 
3. Click on the Selection panel tab in the Structure Tree 
4. Click on the Faces with same color option under the Same color folder in the Selection panel 
5. All the faces with the same color as the originally selected face will be selected. 
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You can now pre-highlight a Component pattern member by hovering over the Component node under 
the pattern node in the Structure tree. Previously, hovering over the component under the pattern node 
in the Structure tree did not pre-highlight the component. 

 
 
You can now save a drawing sheet as a 2D PDF which reflects the current format and size properties of 
the drawing sheet. You can also now Print to PDF from a design window and the design window and its 
contents will scale to fit the current paper size of the selected printer. The Shaded Quality is 
automatically set to 110 dpi, which is best for on-screen viewing, and this value can be modified by 
changing the property in the Print Settings menu (300 is better for printing). 
 

 
Now, when you copy a subcomponent along with it parent and paste it into a new design window, the 
subcomponent retains its relationship to and within the parent component. Previously, the 
subcomponent was flattened to the same level as the parent component in the structure tree, and the 
geometry within each component existed in a new place in the design window space, separated from 
each other.  
 

 
You can now enter commas as European numeric character-separator in the dimension fields for 
Standard Holes, Option panels, and Sketches.  

 
Update Components on Pattern has now been moved to the RMB menu for the mating condition in the 
Structure Tree. Previously, the option was in the RMB menu for assembly-related Components in the 
Structure Tree. 

 
Now, the Move Each to New Component context menu item only appears when multiple items are 
selected in the Structure Tree. Previously, the menu item existed in the context menu when RMB 
clicking on a single component but was grayed out to show that the option was not available. 

 
There is now a submenu called Source in the RMB menu for Components. The following options have 
been moved to this submenu: Make Independent, Replace Component, Use Internal Copy, Internalize 
All, and Convert to External. Previously, all of these options, except for Internalize All, were located in 
the main RMB menu for components. 

 
There is now an Internalize All option in the Source submenu in the Component context menu. This 
option internalizes any external files below and including the selected node in the structure tree. There 
is a progress bar with the Stop button to allow for canceling the command.  
 

How to Internalize All Components: 

1. RMB click on an external Component in the Structure Tree 
2. Hover over the Source submenu to display more options 
3. Click the Internalize All option. 

 

 
There is now an option in the Popular section of the SpaceClaim options to enable Show popup progress 
messages for the Volume Extract tool and when Importing files. This option is checked ON by default.  
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You can now use the Origin tool as an action-object tool to quickly place an origin at any location in your 
design where you want to anchor the Move tool. Click Origin in the Insert group on the Design tab, then 
position and insert the origin.  You can also still click the Move tool and, after clicking Origin, 
automatically position and insert the origin.  
 

Pull tool   
 
A new dropdown box now displays in the Pull Tool section of the Change advanced SpaceClaim options 
in the Advanced screen in SpaceClaim Options. From the Default extrude behavior dropdown box, select 
Automatic, Add, Cut, or No Merge to set the initial state of Pull. The Automatic option selects by default, 
as always. 

 
 
You can now pull the axis of a slot up to the axis of another slot. Previously, this action did not produce 
the correct geometry.  

 

 
You can now pivot two separate edges together when pulling in one direction, as shown below.            

 
 

 
You can now move a circular edge of a flat surface the same way you move a circular sketch curve, as 
shown below.  
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You can now draft a face of one pattern member and see the other pattern members modified as well. 
Previously, drafting a face of one pattern member only changed the geometry of the pattern member 
being modified. This works with the new pattern tools as well as in the move tool.  

 
Previously, when pulling on a face with an offset relationship, you had to pull on the baseline face to be 
able to pull both offset faces together. Pulling on the non-baseline face resulted in an extruded feature. 
Now the behavior has changed such that you can pull on either face, regardless of which one is the 
baseline face, and the faces will pull together with their offset dimension maintained.  
 
This option is ON by default. If you do not want to maintain the offset behavior when pulling on a face 
with an offset relationship, select the Maintain offset checkbox from the Options panel. Deselect it to 
release the offset relationship between the two faces. 

 
With the Cut option selected in the Options-Pull panel, you can now pull a face on a solid and cut 
through other bodies during the pull process. Previously, the cut process ended after the first body was 
cut, and, without the Cut option enabled, pulling a face would start cutting an intersected body in 
another component when the topology of the first body changed. The image set below shows that, with 
the Cut option selected and with Pull mode on, the face cuts completely through each separate body of 
the design.  
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Measure 
 
The Min. distance between objects measurement now displays when you measure the distance 
between objects with the Measure tool.  

 
 
 

 
When selecting on a point with the Select tool, the X, Y, Z location now display in the status bar.  

 
There are now minimum and maximum edge dihedral angles values in the Analysis section of the 
Properties panel when selecting a dihedral edge with the Dihedral tool in the Quality group on the 
Measure tab. The following images show a model with variable dihedral angles, and the edge analysis 
that displays when both edges are selected. 
 

  

 

 
There is now a Units option in the Measure tool which allows you to change the units of measurement 
quickly and easily without having to change the unit system of the document.  
 

Sheet Metal 
 
You can no longer use the Bend tool to attempt to create a bend line which coincides with an edge. 
Previously, the Bend tool would show a preview bend up line without any reliefs. The user would have 
seen the preview, but upon clicking the Complete button, no result was produced, nor was there an 
error message.  
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Faces which have beads can now be moved with the Move tool. Previously, the user would receive an 
error message stating the object (the wall) could not be moved.  

 
Partial hem parameters can now be modified in the Properties panel. Previously, attempting to modify 
the parameters did not produce the correct result  

 
When selecting on an edge to create a bend angle, modifying the Bend Angle option now propagates to 
the pull edge handles immediately. Previously, the handles did not display the change until the bend 
was actually being created during the pull.  

 
The Convert tool now converts a model - with complex geometry - to sheet metal six (6) times faster 
than the previous conversion speed.  

 
You can no longer create hems on non-thickness edges, such as those created with chamfers. Previously, 
this geometry was possible, but has been determined as an unrealistic manufacturing scenario.  

 
The Unfold button is now enabled when you select a single face of a sheet metal part. Previously, you 
could select on multiple faces to unfold a sheet metal part. However, the second or third face selection 
was not required in order to execute the unfold action.  

 
An error message now displays when you attempt to use the Split tool on a corner of a sheet metal part. 
Previously, this action produced a small step, which appeared as offset from the edge that you were 
attempting to split from.   

 
 
There is now a Marker tool in the Create group on the Sheet Metal tab.  

Use the  Marker tool in the Create ribbon group on the Sheet Metal ǘŀō ǘƻ ŎǊŜŀǘŜ ƻƴŜ ƻǊ ƳƻǊŜ ΨŎǊƻǎǎ-
ƘŀƛǊΩ ǇƭŀŎŜƘƻƭŘŜǊ ƳŀǊƪŜǊǎ ƻƴ ǇƭŀƴŀǊ ǎƘŜŜǘǎ ƻǊ ǎƛŘŜǿŀƭƭǎ όŦƭŀǘ ǎǳǊŦŀŎŜǎύΦ  These marker objects move along 
with the walls on which they are initially placed. 
 
To create a marker: 

 

2. Click the  Marker tool in the Create ribbon group on the Sheet Metal tab. 

3. Click on a surface to place the marker. 
To move a marker: 

1. Click the Move tool in the Edit ribbon group on the Sheet Metal tab. 

2. Click the marker you want to move. 
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3. tǳƭƭ ǘƘŜ ƳŀǊƪŜǊΩǎ handles to move the marker to a new position. 
 
There is now a Double Wall tool in the Create group on the Sheet Metal tab.  

Use the  Double Wall tool in the Create ribbon group on the Sheet Metal tab to create a folded full or 
partial double wall. 
To create a double wall: 

1. (Optional) Make room for the double wall by adding the material thickness to the inside radius 
of any existing bends inside which new bends will be created when doubling.  

2. Click the  Double Wall tool in the Create ribbon group on the Sheet Metal tab. 

3. Use the Ctrl key to select the face or set of faces where you want to place the double wall bend. 

4. Click the Select Edges tool guide, then click the edge or edges where you want to place the 
bend. 

5. Click the Complete tool guide. 

 
 

There is now a Gusset tool in the Create group on the Sheet Metal tab.  

Use the   Gusset tool in the Create ribbon group on the Sheet Metal tab to create one or more flat or 
cylindrical gussets.  
To create a flat gusset: 

  

1. Click the  Gusset tool in the Create ribbon group on the Sheet Metal tab. 

2. Click on the bend where you want to position the gusset. 

3. Click to place the gusset. 
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To create a cylindrical gusset: 

  

1. Click the  Gusset tool. 

2. Click on the bend where you want to position the gusset. 

3. Select the Cylindrical gusset type in the tool options panel. 

4. Click to place the gusset. 

 
You can now move a gusset from one position to another. 

To move a gusset 

5. Click Move in the Edit group on the Sheet Metal tab. 

6. Select the gusset that you want to move.  

7. Move the gusset along the bend axis to relocate the gusset to a new position. 

 
 

You can now create a card guide form, such as for use when designing a sub-rack. 

To create a card guide 

1. Click Forms  in the Create group on the Sheet 
Metal tab. 

1. Select the Create Card Guide ς Double Rectangle 

form  from the Special gallery group.  

2. Click on a face to place the form.  

¶ Before you place the form, you can edit the 
ŦƻǊƳΩǎ ǇŀǊŀƳŜǘŜǊǎ ƛƴ ǘƘŜ Options panel.  

¶ !ŦǘŜǊ ȅƻǳ ǇƭŀŎŜ ǘƘŜ ŦƻǊƳΣ ȅƻǳ Ŏŀƴ ƳƻŘƛŦȅ ǘƘŜ ŦƻǊƳΩǎ ǇŀǊŀƳŜǘŜǊǎ ŦǊƻƳ ǘƘŜ Properties panel. 

3. Double-click to complete the form, or, click the Complete tool guide. 
 

The actual geometry used to create a new Thread Punch form now results in creating a realistic object. The object 
now unfolds correctly. Previously, the bend radius value did not reflect the correct value of the selected object, 
thus not creating an accurately drawn object. Because of this, the object did not unfold correctly. 



 
 

  
 

Page 19 

  SpaceClaim 2011+ Release Notes 

www.spaceclaim.com 

 
 

You can now set the bend deduction (BD) for a bend calculation to a negative value. From the Properties panel, 
modify the Bend Deduction under Sheet Metal. This allows you to correctly calculate the BD from BA. Previously, 
the absolute value of a bend deduction corresponded to exact value, not the absolute value of a bend allowance, 
which resulted in positive value only.  

 
 

When box selecting a sheet metal junction, the status message now displays the selection as a junction. 
Previously, the status message recognized this selection as multiple faces. For example, when box selecting a 
bend, the status message displays 1 Bend instead of 2 Faces. 
The Identify tool now allows the user to box select identifiable sheet metal geometry. Box selecting selects front 
and back faces of the pre-identified sheet metal geometry. Previously, box select was not available in the Identify 
tool. 
 

With a part selected in the Structure tree, a new K-Factor Type option now displays In the Sheet Metal 
group of the Properties panel, as shown below: 

  
The Variable option is set by default, and graph function behavior is unchanged from previous 
versions. However, the Constant K-Factor type option allows you to enter a numerical value for the 
part. Using this option, you can map the design to other mainstream CAD functionality, or, adjust the 
ŘŜǎƛƎƴ ǘƻ ŀ ƳŀƴǳŦŀŎǘǳǊŜǊΩǎ ǳƴƛǉǳŜ ǎǘŀƴŘŀǊŘǎ ƻǊ ǘƻƭŜǊŀƴŎŜǎΣ ǘƻ ŀŎƘƛŜǾŜ ŘƛŦŦŜǊŜƴǘ ǳƴŦƻƭŘƛƴƎ results. 
Previously, the K-Factor Type option was not available in the Properties panel.  
The graph below shows a constant K-Factor: 



 
 

  
 

Page 20 

  SpaceClaim 2011+ Release Notes 

www.spaceclaim.com 

 

Bend table files are comma-separated value (CSV) files, which you can edit in a spreadsheet editor. You 
can now enter a value for BendAlllowance in a bend table to obtain the desired bend allowance, using 

the keyword description Type parameter BendAlllowan ce . The 

Properties panel displays bend allowance parameters as shown to the 
right: 

Adding this value enables you to assign bend allowance tables to a model to 
calculate the developed lengths for unfolded or flat patterns to be machined. 

Previously, BendDeduction was the only supported Type value, as 
displayed in the sample bend table below: 

 
 

 

You can now use the Up To tool guide to pull one plane up to another when a sheet metal model is in flattened 
mode. After you flatten the model and select a face to pull, click the Up To tool guide, then click the object that 
sets the plane up to which you want to pull.  

 
You can ƴƻǿ ƳƻǾŜ ŀ ƘŜƳΦ aƻǾƛƴƎ ŀ ƘŜƳ ŀŘƧǳǎǘǎ ǘƘŜ ƭŜƴƎǘƘ ƻŦ ǘƘŜ ƘŜƳΩǎ ŦŀŎŜΦ tŀǊǘƛŀƭ ƘŜƳǎ Ŏŀƴ ƳƻǾŜ ŀƭƻƴƎ ǘƘŜ 
bend as well, as shown: 

 
You can now unfold sheet metal with double-walled parts that include a complex unbending edge. Previously, the 
sheet metal would unfold, but the unbending edge of the double wall would not unfold correctly, resulting in an 
in inaccurately unfolded design.  
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You can now use Fill or Delete to 
remove a hem. With the hem 
selected, select Fill from the Edit 
group in the Design tab, or right 
mouse click and select Delete from 
the context menu. 

 
When creating multiple splits along a 
sheet metal part, regardless of whether you use one or two cutter points or bend direction, the resulting bend 
now spans the length of the sheet metal part across all splits, and, on both sides of the split(s). 

 
 

You can now completely unfold (flatten) a sheet metal part that includes holes that touch a bend or are included 
in an object that includes a bend, as shown in the image set below: 
Previously, a sheet metal part would not unfold after inserting a hole.  

 
When you now move a wall, any associated sheet metal objects associated with that wall, such as junctions, 
edges, reliefs, corner reliefs, and bends, also move with the wall. Previously, only the selected wall would move, 
ŀƴŘ ǘƘŜ ǿŀƭƭΩǎ ŀǎǎƻŎƛŀǘŜŘ ƻōƧŜŎǘǎ ǿƻǳƭŘ ǊŜƳŀƛƴ ƛƴ ǇƭŀŎŜΣ ǊŜǎǳƭǘƛƴƎ ƛƴ ŀƴ ǳƴǊŜŀƭƛǎǘƛŎ ǊŜǎǳƭǘΦ 

 
 

You can now use the Pull tool to create a new offset wall in sheet metal. Previously, you could create only inside 
or outside walls in sheet metal. When you create an offset wall, you offset the sheet to allow space for the bend 
when pulling, essentially pulling the wall with the bend starting exactly from the edge location.  

 
You can now move a joggle along a bend. Previously, the Move tool functionality was not available to move 
joggles in this direction. 

 

Circular text can now be converted to lightweight (LW) text in sheet metal. Lightweight text is transparent, and is 
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used to represent text objects in a virtual way (so that further operations on the part do not have to recalculate 
all the new graphics data dealing with text).  In lightweight mode, the text cutouts seen by the user are only 
recreated when the text is edited, as opposed to every time any other action is performed on the model.   

 

 

Now, when you use the Fill tool to fill a gusset, the bend geometry on which the gusset is defined 
remains intact. Previously, filling a gusset resulted in breaking the bend on which it was defined, which 
created incorrect geometry when the design was flattened.  

When using the Up To tool guide to move a face, form, or bead to a new location on a part, such as an 
edge or face, you can now select a direction with a Move tool handle and click the Up To tool to 
correctly move the face, form, or bead to the new location. Previously, you could select a direction 
with a Move tool handle and click the Up To tool guide, but the face, form, or bead would not move to 
the desired location.  

²ƛǘƘ ŀ ƘŜƳ ǎŜƭŜŎǘŜŘΣ ȅƻǳ Ŏŀƴ ƴƻǿ ƳƻŘƛŦȅ ǘƘŜ ƘŜƳΩǎ Bend Allowance (BA) and Bend Deduction (BD) 

parameters in the Sheet Metal ƎǊƻǳǇ ƻŦ ǘƘŜ tǊƻǇŜǊǘƛŜǎ ǇŀƴŜƭΦ ²ƘŜƴ ȅƻǳ ŎƘŀƴƎŜ ŀ ƘŜƳΩǎ .!Σ ǘƘŜ .5 
ǇŀǊŀƳŜǘŜǊ ŀƭǎƻ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ǳǇŘŀǘŜǎΣ ŘŜǇŜƴŘƛƴƎ ƻƴ ǘƘŜ ƘŜƳΩǎ other parameters, such as Inner Radius, 

Height, or Angle. Previously, after creating a hem, the bend radius or angle could not be modified.  

²ƛǘƘ ŀ ƧƻƎƎƭŜ ǎŜƭŜŎǘŜŘΣ ȅƻǳ Ŏŀƴ ƴƻǿ ƳƻŘƛŦȅ ǘƘŜ ƧƻƎƎƭŜΩǎ Inner Radius and Angle parameters in the Sheet 

Metal ƎǊƻǳǇ ƻŦ ǘƘŜ tǊƻǇŜǊǘƛŜǎ ǇŀƴŜƭΦ ²ƘŜƴ ȅƻǳ ŎƘŀƴƎŜ ŀ ƧƻƎƎƭŜΩǎ .!Σ ǘƘŜ .5 ǇŀǊŀƳŜǘŜǊ ŀƭǎƻ 
ŀǳǘƻƳŀǘƛŎŀƭƭȅ ǳǇŘŀǘŜǎΣ ŘŜǇŜƴŘƛƴƎ ƻƴ ǘƘŜ ƧƻƎƎƭŜΩǎ ƻǘƘŜǊ ǇŀǊŀƳŜǘŜǊǎΣ ǎǳŎƘ ŀǎ Inner Radius, Height, or 
Angle. Previously, after creating a joggle, the bend radius or angle could not be modified.   

Corner reliefs are created automatically and by default when you create a sheet metal design or 
convert a design to sheet metal. Converting corner reliefs to other types is a standard SpaceClaim 
feature. Sometimes, later rotations and wall modifications would not be possible because of 
complicated corner geometry. 
To achieve a solid rotation and retain the correct geometry, before rotating sheet metal wall faces, 
now you can automatically convert the corner reliefs to a default corner relief (which is purposely a bit 
over-sized). When finished with the user-requested rotation, the system automatically restores the 
corner reliefs to their original relief type.  Many more modifications, particularly to walls with 
complicated corner reliefs, should now be possible. 

 

You can now select a wall as an object, and click the Delete key; or right-click and select Delete to delete 
a wall. When you delete a wall, you also delete any objects related to the wall, such as junctions or 
reliefs. 

 
Now, when you move a double wall, the wall and any objects related to the wall, such as junctions or 
reliefs, move together, as shown in the image below: 

 
Previously, double-walls and their adjacent or associated parts did not move together. 
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You can now use the Pull tool to pull an edge of a double-wall into a sheet metal wall, as shown in the 
image set below. Previously, you could not pull an edge of a double-wall.  
 

  

 
You can now not only rotate double walls around a bend axis, but you can also click anywhere on the 
ƳƻŘŜƭΣ ǎǳŎƘ ŀǎ ŀ ŦŀŎŜΣ ŀƴŘ ǊƻǘŀǘŜ ǘƘŜ ŘƻǳōƭŜ ǿŀƭƭ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ƳƻŘŜƭΩǎ ƎŜƻƳŜǘǊȅΦ !ǎ ǎƘƻǿƴ ƛƴ ǘƘŜ 
examples below, how the double wall rotates depends on which face is selected: 
 

 

 
 

 
 

 
Now, when you select a sheet metal part and click Ctrl+ Move, the copied sheet metal part retains and 
recognizes all features of your selection, thus providing accurate part replication. Previously, the copied 
part did not retain bends, reliefs, hems, gussets, or other sheet metal features.  
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Creating holes in a sheet metal flat part and then including those holes completely within a bend zone 
now results in holes that bend up when you create a bend, as shown in the image below. Previously, 
holes in this design scenario did not bend up.   
 

 
When you use the Convert tool to convert a body to sheet metal, or, are working with an existing sheet 
metal body, only the sheet metal faces that are separated by the default sheet metal thickness are 
shown in blue, but not sheet metal that varies in thickness from the default, as shown in the image to 
the right:   

 
 

Now, when you convert a part that includes a notch, and then click 
the Identity tool and select the Notches tool guide, notches are 
clearly identified by the cyan color in the sheet metal part, as 
shown in the notch in the image to the right:  
 
 
 
 

 
You caƴ ƴƻǿ ǎŜǘ ǘƘŜ ƎŀƎŜ ŦƻǊ ŀ ƳŀǘŜǊƛŀƭ ǳǎŜŘ ƛƴ ŀ ǎƘŜŜǘ ƳŜǘŀƭ ǇŀǊǘΦ DŀƎŜΣ ƻǊΣ ΨƎŀǳƎŜΩΣ ƛǎ ǘhe thickness of 
the metal organized by numbers: the smaller the number the thinner the metal. A sheet metal design or 
component of a design must be assigned a material in order for the gage dropdown to display. You 
Ŏŀƴƴƻǘ ǎŜƭŜŎǘ ŀ ƎŀƎŜ ŦƻǊ ŘŜǎƛƎƴǎ ƻǊ ŎƻƳǇƻƴŜƴǘǎ ǘƘŀǘ ŀǊŜ ŀǎǎƛƎƴŜŘ ǘƘŜ Ψ¦ƴƪƴƻǿƴ aŀǘŜǊƛŀƭΩ ƻǇǘƛƻƴΦ  
 
To assign a material, from the Structure tree select the design at the top level, or select the component 
for which you want to assign a material, and then click the Material Name dropdown from the Material 
group in the Properties panel.  From the Thickness group in the Properties panel, click the gage drop 
down, and select a gage. Assigning a gage enables you to control the thickness of a sheet metal part at a 
more granular level. 
 

 
For sheet metal bends that are greater than 90 degrees, the definition of the K-factor calculation has 
changed. Previously, Bend Deduction = 2 * SBout ς Bend Allowance 
 
Now, for angles up to 90 degrees, the length of one side of a part is defined as a tangent length or a 
radius length, as shown in the image on the left, below. For larger angles, a reference point for 
measuring the length of a part cannot be practically measured, so tangent dimensioning is used instead, 
as shown in the image on the right: 
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Now, when you click the Convert tool and select a surface body of a design, the surface body 
automatically thickens into a sheet metal body at the default sheet metal thickness. This enhancement 
eliminates the need to redo a surface you may have sketched prior to converting the design to sheet 
metal. For example, if you make a mistake and start sketching a surface, not in Sheetmetal, you can click 
the Convert tool to immediately convert it when you go to the Sheetmetal tab, and not have to redo the 
sketch. 
 
You can use the Bend tool from the Create group in the Sheet Metal tab to place multiple bend lines 
along a surface. Now, existing in-ǇǊƻƎǊŜǎǎ ōŜƴŘǎ όǘƘŀǘ ŀǊŜ ƴƻǘ ȅŜǘ ōŜƴǘΣ ƻǊ ΨŦƭƛǇǇŜŘύ ǊŜƳŀƛƴ ŘŜ-selected 
as you place one or more new, additional bend lines along the sheet metal surface. 

 
 
All now displays as the first option in the Highlight dropdown in the Show group on the Sheet 
Metal tab, as shown in the image to the right. Selecting this option enables this tool to highlight 
each object in the component. Deselect the All option to clear all Highlight checkboxes. 
 

The Highlight dropdown in the Show group on the Sheet Metal tab now displays a Tabs option, 
which, when selected, highlights all tabs in your sheet metal design. 
 
 
 

 
Now, you can define Bend Allowance calculations when you bend up (from flat and 3D) a sheet metal 
component, or when you create a joggle. 
 
Begin creating a Bend Up, then, before you click the Complete button to create the bend, you can use 
the Bend Options panel to choose your bend parameters, including Vee Die width setting. After you 
create the bend, you can modify these settings, here and in the Properties panel. 
 
From the Properties panel, in the Sheet Metal group, select a Bend Table from the dropdown. You can 
enter the bend allowance values you want for your model before you make the bend or change bend 
ŀƭƭƻǿŀƴŎŜ ŎŀƭŎǳƭŀǘƛƻƴǎΦ .Ŝ ǎǳǊŜ ȅƻǳǊ ōŜƴŘ ǘŀōƭŜ ŘƻŎǳƳŜƴǘ ƛǎ ŎƭƻǎŜŘ ǇǊƛƻǊ ǘƻ ƳƻŘƛŦȅƛƴƎ ǘƘŜ ōŜƴŘΩǎ 
parameters in the Options panel. 
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When creating a joggle, among other values, you can enter a value for Bend Allowance from the Bend 
Options panel. As with creating a bend, you can also modify Bend Allowance by working with a bend 
table. 

 
Similar to other objects, such as a gusset or hem, a tab is now selectable as an object. As such, you can 
select the entire ǘŀōΣ ŜŘƛǘ ǘƘŜ ǘŀōΩǎ ǇŀǊŀƳŜǘŜǊǎ ƛƴ ǘƘŜ tǊƻǇŜǊǘƛŜǎ ǇŀƴŜƭΣ ŀƴŘ ǳǎŜ ǘƘŜ Fill tool (F) to 
remove a tab. 

 
Lƴ ǘƘŜ hǇǘƛƻƴǎ ǇŀƴŜƭΣ ȅƻǳ Ŏŀƴ ƴƻǿ ǎŜǘ ŀ ǘŀōΩǎ ŎƭŜŀǊŀƴŎŜΦ Clearance is the amount of space that exists 
between tab faces. To set the space between tabs, when creating a tab you can enter the setting in the 
Clearance text box in the Tab Options panel. Once you create the tab, you can edit the clearance setting 
in the Sheet Metal group of the Properties panel.  

  
 

You can now click the Identify tool, and then click the Tabs tool guide, to locate and identify all tabs in 
your model. The tool guide identifies the tabs in red by default. Click the Complete button to display the 
tab in blue (default). 

 
You can create and/or edit tabs and slots in walls that intersect in the same body. 
The image to the right shows a vertical and horizontal wall intersecting in the 
same body, with the walls connected by a set of tabs and slots 
 
 
To change the shape of the sharp edges on tabs, click Round Radius from the 
Sheet Metal options panel. You can also change the edges when you create the 
tab by selecting Rounds or Chamfers from the Tab Options panel. These settings 
enable you to have more control and selection over tab and slot design. The 
image set below shows a sample of tabs with rounded corners, and tabs with 
chamfered corners: 
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You can now use the Mirror tool to mirror sheet metal components (not solids). In the Structure tree, 
select the solid, then right-click and choose Move to New Component. Select Plane from the Insert 
group on the Design tab to place the plane on the face you want to mirror. Click the Mirror tool, select 
the plane, and then select the component that you want to mirror. The last image in the set below 
shows a mirrored sheet metal component: 
 

 
 

 
Previously when attempting to identify notches, 45 degree and xy bevel notches were not identified. 
Now, when selecting the notches tool guide in the Identify tool, all notches are highlighted correctly.  

 
Previously, when moving a parent wall in a linear direction with a tab junction attached, the tab junction 
would separate, which is not the correct behavior. Now a tab stays connected when moving a parent 
wall in a linear direction. See example below.  

 
There is now an Unfold Layers section in the Options UI for Sheet Metal. This section has options for 
assigning default layer colors and linestyle for Bend Lines-Up, Bend Lines-Down, and Forms. Other layers 
include Overall Dimensions and Bend Dimensions but there is only a color option for these layers.  
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In the layers panel, you will now see a layer for each of the following features when the part is in an 
unfolded state: Dimension, Bend Lines Up, Bend Lines Down, Bend Dimensions, and Forms. All of these 
layers are turned off by default except for the Dimension layer. Previously, only Dimension, Bends, and 
Bend Dimensions were present in the layers panel.  
 

 
The Annotation Datum Plane and Annotation Datum for curves have now been moved to the Bend 
Dimensions layer which allows them to be hidden while still showing the bend lines. This proves to be 
helpful when exporting to line drawings.  
 

 
Now, sheet metal features remain highlighted when switching between tabs. Previously, if you had 
created a sheet metal part then switched to the design tab, for example, the highlighted sheet metal 
features would be turned off until the sheet metal tab was activated again. Sheet metal objects are 
always up-selected from faces in the sheet metal tab as well as all other tabs. You can pick on any of 
these features by simply just clicking on one face, rolling the mouse wheel to select a face behind 
another, or by box selecting the feature.  
 
When in the Design tab, the Select, Pull and Move tools work as they do in the Sheet Metal tab, 
however, if you want to use the Design Tab tools as usual there is a context menu option called Suspend 
Sheet Metal when you RMB-click the Sheet Metal part in the structure tree. This will turn off highlighting 
the Sheet Metal features and is similar to switching to the Design tab before this change was 
implemented. 

 
There is now a tool guide in the Bend tool, Select Curves, which allows you to select a sketch curve on a 
body to be bent up along with the faces with the chosen bend lines.  
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You can now use the  Hinge tool to make hinges on Sheet Metal parts which rotate about the pin of 
the joint using the Move tool. See example to the right for rotating a hinge. Hinges can only be made 
between separate solids (ones that are connected by a Junction). Hinges are now part of Highlight drop 
down menu in the Show group and are highlighted in the same color as Tabs. You can select the Hinge 
object like other Sheet Metal objects by clicking on a face to select the entire feature. Hinge Properties 
include Pin Diameter, Pitch, Knuckle length, End play, and Paint clearance. There is also a Flip checkbox 
which when checked on alternates the hinge curves along the selected edge. Currently this option is 
only available in the options panel before completing the Hinge (not redefinable.) 

 

To Create a Hinge: 

1. Create one of the three overlap junctions at a bend on a sheetmetal part. Or create a split across 
a face of a flat wall.  

2. Select the Hinge tool from the Create Group on the Sheet Metal tab 
3. Select on a straight edge which is perpendicular to a thickness edge. You can also select on one 

edge out of two flat Sheet Metal walls which are next each other in the same plane. 
4. If it is possible to create a Hinge on the selected edge a preview will show in blue. You can ctrl + 

select multiple edges to create multiple hinges at a time. Creating multiple hinges at a time 
means they will all have the same properties after completion. You may then change the 
properties of an individual hinge in the properties panel.  

5. Enter in desired values for each of the 5 properties 
6. Click the Complete button or hit the enter key to complete the hinge. 

 
Reverse and Flip functionality has been implemented in the Tab tool. RMB-click on a tab feature to 
select either of the two new options. The Flip option alternates the tabs along the selected edge to be 
the opposite of the current interlocking position. The Reverse option picks the edge of the other body 
which the tabs will intersect so that the male teeth are made on that edge instead of the originally 
picked edge to create the Tab.  

  
 

 
For Hinge and Tab tools, there is a checkbox for the Flip option. Previously, this was called the Reverse 
option. It was changed because the Reverse option is actually effected by picking the edge of the other 
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body whereas the Flip option alternates the geometry along the axis of the edge picked for the Tab or 
Hinge.  

 
When pulling on a face of a Sheet Metal wall, the pull tool now acts like the move tool so that the offset 
face moves along with the selected face and bend junctions are maintained correctly. Tabs will also be 
maintained when pulling on a wall which has an interlocking tab feature attached.  
 

 
Hinges can now be filled with the Fill tool.  

 
Angled Notches (or chamfers) can now be identified with the Identify tool on the Sheet Metal tab.  
Previously, angled notches were not highlighted automatically when entering the Notches tool guide in 
the Identify tool. See example below.  

 

 
 

 
Bend Table Name and Thickness properties have been added to the Insert Field dialog box in the Note 
tool mini toolbar. To add these properties to a note click on the top level component and set the 
category to Selected Object to display the property options.  This will allow users to place these 
properties as a Field Note into a Note that automatically updates when the properties change.  

 
Card guide forms are now mirrored properly. Previously, the mirrored component only had slot cutouts 
from the form but not the bump over the top of the cutouts.  

 
The default colors and linestyles for unfolded bend lines have been changed. Bend up is now a solid 
green line and Bend Down is now a dashed green line. Previously, the colors and linestyles for both lines 
were royal blue and dashed by default. Of course the user can re-set these via their layers. 

 
There is now an Invert Form option in the RMB context menu for forms. Clicking the option flips the 
form to the opposite side of the Sheet Metal wall.  This option only works for Forms originally created in 
SpaceClaim, not ones that are Identified from foreign sources.   

 
You can now press the Delete key when a Form is selected to remove the Form association from the 
object. The geometry remains and you can use the Identify tool to change it back to a Form object if 
needed. This is consistent with other Sheet Metal objects such as Notches and Beads, Reliefs, Junctions, 
etc.  

 
Overall dimensions are calculated on an unfolded Sheet Metal part and are placed on the Dimension 
layer. Previously, when creating a new drawing sheet from the unfolded Sheet Metal part, the overall 
dimensions were transferred to the drawing sheet and placed on the active layer along with the Sheet 
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Metal geometry, meaning you could not have hidden these dimensions without also turning off the 
visibility of the geometry.  

 
The Select Curves toolguide is no longer available when the Bead option in the Bend tool is active. You 
can no longer use partially-crossing curves to create beads with the Bend tool. Use the standalone Bead 
tool to create beads which do not extend all the way across a Sheet Metal face.  

 
The Split tool now works on Sheet Metal faces whose thickness edges are not square (90° angle) to the 
face chosen for the split.  
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Detail  

 
In the Linestyle options section of the Detailing screen in SpaceClaim Options, there is now a line style rendering 
dropdown menu. To enable line style options, you must select the Lineweight checkbox in the Show group of the 
Display tab. New line style options include Dashed, Long dash dotted, Long dash double dotted, and Dotted.  
Using a non-solid line style helps to differentiate a detail view with clipped edges when in wireframe mode. Previously, 
you could change line thickness only, and only show a solid line weight on a clipped edge.  

 
 

You can now select a Microsoft Windows 3.1 single line stroke font when creating a Note. With the note selected, 
choose Modern, Roman, or Script from the Font dropdown in the mini-toolbar. The addition of single stroke fonts 
enables you to use a simpler, single line font when etching or laser-cutting in sheetmetal, where the width of the 
character is determined by the width/focus of the laser beam. Previously, only TrueType fonts (multi-line) were 
available. 

  
 
 

 

 

 

 

 

 

 

 

 

 

 

 

You can now create and edit circular Note text. Text types include clockwise (CW) or counterclockwise 
(CCW). To prevent 0 radius, a reasonable radius is automatically chosen when CW/CCW is user-selected. 
The circle center is indicated by a cross-hair marker. The circle radiuss displays as a visual guideline. Use the 
pull handles to size the circle, or, adjust the orientation of the note by dragging the rotation handle. You can 
enter or change new radius settings in the Options panel.  

As shown in the image set below, with circular text you can create: 

¶ Single line text 

¶ Multi-line text. Type the first line of text, and then press Enter to create an additional line of text.  

¶ Formatted single or multiple line text. Use the mini-toolbar to format circular note text. You can 
change the font, font size, and style of all or some of the text; however, you cannot underline circular 
text. Both True Type and Microsoft Windows 3.1 fonts are available for creating circular note text. 
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To create a Note with circular text 

1. Select the Create tool   from the Annotation ribbon group in the Detail tab. 

2. Click a face to create the plane on which to place the note. 

3. Click to place the note on the plane. 

4. Enter the text of the note. 

5. In the Properties panel, select Clockwise or Counterclockwise from the Type dropdown. 

6. Click the face to update the note. 

 

To edit a Note with circular text 

1. Click the circular note to display the radius and the mini-toolbar. 

2. Click the note text. 
The text box changes in shape from circular to rectangular for easier editing. 

3. Edit or format the text as needed. 

4. Click the face to update the note with your changes 
 

 

 

 

To create a Note with circular text 

7. Select the Create tool   from the Annotation ribbon group in the Detail tab. 

8. Click a face to create the plane on which to place the note. 
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9. Click to place the note on the plane. 

10. Enter the text of the note. 

11. In the Properties panel, select Clockwise or Counterclockwise from the Type dropdown. 

12. Click the face to update the note. 

 

To edit a Note with circular text 

5. Click the circular note to display the radius and the mini-toolbar. 

6. Click the note text. 
The text box changes in shape from circular to rectangular for easier editing. 

7. Edit or format the text as needed. 

8. Click the face to update the note with your changes. 
 

 
To get started with creating circular text, select the Create tool from the Annotation ribbon 
group in the Detail tab. In the Properties panel, select Clockwise or Counterclockwise from the 
Type dropdown.  Once you create your circular text, you can use leading spaces (inserted 
before text or within text) and trailing spaces (inserted after text) to position text around the 
circle radius as needed. 
 
You can now anchor text, of regular, circular, and mirrored types. Where you anchor the text 
determines the direction that the text will fill the note. For example, if you select the Left Top 
position, as you type, the expanded text box flows from left to right and top to bottom. 
Choose an Anchor option In the Position group in the Properties panel. Anchor positions include 
Left Top, Left Bottom, Right Bottom, Right Top, Left Center, Right Center, Bottom Center, or 
Center. This feature enables you to influence the position and size of how a note will fit on a 
plane. 
 
When including Hebrew characters in any type of note, be advised that the modern Hebrew 
alphabet is written and read from right to left. English alpha characters and all numeric 
characters (letters and numbers) are written and read from left to right. Hebrew text 
automatically right justifies as it is entered in your note. If note text includes a mix of Hebrew 
and non-Hebrew language, edits you make to the Hebrew text will run from right to left, and 
edits you make in the non-Hebrew text (and numbers) will run from left to right. 
 

Field codes can be included within a note. The text in field codes is variable text; in other words, the text 
within a field is tied to code, so if you change a field code in your note or drawing sheet, for example, a 
date format, the field automatically updates. Some field codes are bi-directional; for example, adding the 
Scale field code to a drawing sheet enables you to change the scale by editing the note, or, change the 
scale by changing the value from the Scale drop-down in the Sheet Setup group in the Detail tab. 

With the note text selected, Click  in the mini-toolbar to insert field codes into your note at the cursor 
location. From the Insert Field dialog box, select one field at a time from the Fields list. Select a Category 
from the dropdown, and click the Format tab to select a format for your field choice. For example, if you 
select the Create field, the Format tab displays a list of possible date formats. Select a format to see a 
field code example in the Example text box. Make your field and format selections and click the Close 
button.  
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You can hover over an area in the design window to highlight the field code as shown below. When 
selected, a field code displays as a note in the status bar. 

 

3D Markup slides display by name, such as Slide1, as components in the Structure tree. To delete a slide, 
you can now select the slide in the Structure tree, and then right mouse click and select Delete to remove 
the slide. 

Because a slide is a component, when you delete a slide from the Structure tree you also delete all of that 
ǎƭƛŘŜΩǎ ƻōƧŜŎǘǎΦ ¢Ƙƛǎ ŦŜŀǘǳǊŜ ŀƭƭƻǿǎ ȅƻǳ ǘƻ ƻǊƎŀƴƛȊŜ ȅƻǳǊ о5 aŀǊƪǳǇ ǎƭƛŘŜǎ ŀǎ ȅƻǳ ǿƻǊƪ ǘƻǿŀǊŘǎ ŎǊŜŀǘƛƴƎ ŀ 
design or finished assembly. Previously, you could not delete a slide in the Structure tree. 

 

 
 
Nine anchor positions now display with non-circular note text. For illustration purposes, the Center 
anchor is shown in the image below: 

 
 
To select an anchor, simply click to make it active.          A selected anchor displays as a red ball on the 
note boundary.  
 
To move a note anchor 

1. Select the anchor, then drag it to a different area of the design window, including anywhere 
inside or outside the note boundary. 

To move an anchor, you can also select a new anchor location from the Position group in the 
Properties panel. 
²ƘŜƴ ȅƻǳ ŎƘŀƴƎŜ ŀƴ ŀƴŎƘƻǊΩǎ ǇƻǎƛǘƛƻƴΣ ǘƘŜ Anchor dropdown automatically updates in the 
Properties panel.  
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Where you anchor the text determines the direction that the text will fill the note. For example, if you 
select the Left Top position, as you type, the expanded text box will flow text from left to right and top 
to bottom. This feature enables you to influence the position and size of how a note will fit on a plane. 
 
As with non-circular text, you can also work with the same anchor set to change anchor position, and 
determine text direction for a circular note. 

  
²ƘŜƴ ȅƻǳ ŎƘŀƴƎŜ ŀƴ ŀƴŎƘƻǊΩǎ ǇƻǎƛǘƛƻƴΣ ǘƘŜ Radius textbox automatically updates in the Circular Text 
section of the Properties panel. Circular note text includes the rotation handle and two additional 
controls: a radius handle and a center/move handle, as shown in the image below: 
 

 
 
 
 

To rotate a note Select the rotation handle and rotate the note either clockwise or 
counterclockwise. The green rotation handle is located at  the top of the 
handle bar. 

¢ƻ ŎƘŀƴƎŜ ƴƻǘŜΩǎ ǊŀŘƛǳǎ Select the radius handle and move the handle.The radius handle is located 
ƻƴ ǘƘŜ ƴƻǘŜΩǎ radius-defined circle. 

¢ƻ ŎƘŀƴƎŜ ŀ ƴƻǘŜΩǎ 
position 

Select the center/move handle, then drag it to a different area of the 
design window, including anywhere inside or outside the note boundary. 
¢ƘŜ ŎŜƴǘŜǊκƳƻǾŜ ƘŀƴŘƭŜ ƛǎ ƭƻŎŀǘŜŘ ŀǘ ǘƘŜ ŎŜƴǘŜǊ ƻŦ ǘƘŜ ƴƻǘŜΩǎ radius-
defined circle. 

 

 

You can now left-justify, center, or right-justify circular note text. 

To format the text, place your cursor within the text, or select the text you want to format, and use the 

 tools in the Font ribbon group in the Detail tab. All text within the note boundary ς singular or 
multiple lines of text ς will align to the format you set. 
By default, all circular text, whether clockwise or counterclockwise, now displays around the outside 
radius of a circle. 
When designing a model, you can insert sub-components into an assembly multiple times. The QTY 
ŎƻƭǳƳƴ ƛƴ ǘƘŜ ƳƻŘŜƭΩǎ Bill of Materials (BOM) now updates to show the correct number of sub-
components included in an assembly. Previously, the number of items, not sub-components, displayed in 
ǘƘŜ .haΩǎ v¢¸ ŎƻƭǳƳƴΣ ŀǎ ǎƘƻǿƴ ōŜƭƻǿΥ 
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You can now split the cross hatching lines of a cross section plane on a drawing sheet. This interactive 
feature is unique to SpaceClaim. With each new split of a cross-section plane, a new view is created and 
labeled automatically, and hatch lines update as you split or make changes. 
To split a cross section plane 

1. Click the Cross Section View tool on the Detail tab's Views ribbon group. 

2. Click the Select Section View tool guide, and then select the cross section view you want to split. 
You can modify the values in the Options panel as needed. 

3. Click the Cut Existing Section tool guide, and select the location on the cross-section indicator 
where you want to make the split. 

The indicator splits at your cursor location.  

4. Slowly move the mouse to size your split, then click anywhere in the Design window to finalize. 

As you make the split, the cross-section view changes to reflect the new geometry created by 
the split, as shown in the image set below: 

 
 

There is a new  Select Section View tool guide icon for the Cross Section tool. Use this tool to select a 
drawing view to section.   
 

Using the   Cut Existing Sections tool guide, create an offset cross section by selecting an existing 
planar cross section, and then click+ drag a section line, or a segment of a section line. The curve you 
choose determines the direction of the cross-section. When you click, a small red diamond cut indicator 
displays at your cursor location to set the location of the cut, as shown in the image below:  
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The cut indicator slides as you move your cursor along any section line or segment that is parallel to the 
primary direction of the section arrows. The image to the right shows a model with section lines that cut 
across the holes, and two cross-section cuts:  

 
 
 
 
From the Appearance SpaceClaim options screen, you can set the color of cross section planes with the 
Clip face color option, so that they display correctly along cut planes.  The sample images show the cross 
section planes in blue. The default for this option is the body color. 
 

 
 
 

 
There is now a new Hole Table tool in the Annotation group on the Detail tab.  Use this tool to create a 
ǘŀōƭŜ ǘƘŀǘ ƻǊŘŜǊǎ ŀ ŘŜǎƛƎƴΩǎ ǊƻǳƴŘ ƘƻƭŜǎ ōȅ ǎƛȊŜ όŎƭŀǎǎƛŦƛŜŘ ōȅ ŘǳǇƭƛŎŀǘŜǎύ ŀƴŘ ƭŀōŜƭǎ ǘƘŜ ƘƻƭŜǎ ƻƴ ŀ ǇƭŀƴŀǊ 
face. Holes are sorted by in order from left to right, then top to bottom, as shown in the image below:  
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To create a Hole Table, click the Hole Table tool and then click on a planar face that includes holes. 
SpaceClaim creates a datum plane for the Hole Table. Now click+ drag the Hole Table to an empty space 
in the design window. Once you create a table, X and Y axis labels display. 
 
A Hole Table displays in the Structure tree on an Annotation Plane. You can deselect the Annotation 
Plane checkbox to hide the Hole Table. Just like a regular table, you can change the values in the Rows 
and Columns cells in the Properties panel to adjust the number, width, or height of a table element. Use 
the pull handles on the table or chart to size as needed. Use the round handle at the top of the table to 
rotate the table or chart.  To remove a table or chart, select the table, right-mouse click, and select Cut. 
 
A Hole Chart displays the quantity of holes with similar diameters. If you make changes to your design, 
with the table ( or X or Y axis) selected, you can right-click and select Show Hole Chart to create another 
chart, Show Hole Table to create an updated table, or select Save Table As, to save the table as a Web 
(.htm, .html) or XML file.  
When you change the size of a hole, the values in the table update, and the table re-orders and re-
classifies the holes and rows of the table. When you copy and paste a hole, the table updates to display 
ŀ ƴŜǿ Ǌƻǿ ǿƛǘƘ ǘƘŜ ƘƻƭŜΩǎ ·Σ ¸Σ ŀƴŘ 5ŜǎŎǊƛǇǘƛƻƴ ǾŀƭǳŜǎΦ !ŦǘŜǊ ȅƻǳ ŘǊŀƎ ŀ ƭŀōŜƭ ǘƻ ŀƴƻǘƘŜǊ Ǉƻǎƛǘƛƻƴ ƻƴ ǘƘŜ 
design, the table updates to the size and position of the new hole.  To display your changes in a new 
table, right-mouse click and select Show Hole Table. 
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Now, when adding ordinate dimensions to an existing Ordinate Dimension Stack in ISO, auto-jogging 
(the automatic creation of aligned jog points and lines) adjusts the location of all the dimensions to fit 
the added dimension.  Each offset dimension in a stack has a unique line that identifies its connection to 
a point of reference, and to the baseline dimension (0).  

 

 
²ƘŜƴ ƳƻǾƛƴƎ ŀ ƴƻǘŜ ƻǊ ŎƛǊŎǳƭŀǊ ƴƻǘŜΣ ǘƘŜ ƴƻǘŜΩǎ ŀƴŎƘƻǊ όƻǊ ŎƛǊŎǳƭŀǊ ƴƻǘŜΩǎ text center) now snaps to an 
ŜŘƎŜΣ ŀ ǎƪŜǘŎƘ ǇƻƛƴǘΣ ƻǊ ŀƴ ŀȄƛǎΦ {ŜƭŜŎǘ ǘƘŜ aƻǾŜ ǘƻƻƭΣ ŀƴŘ ǘƘŜƴ ǎŜƭŜŎǘ ǘƘŜ ƴƻǘŜΩǎ ǊŜŘ ŀƴŎƘƻǊ ŀƴŘ ŘǊŀƎ ƛǘ 
ǘƻ ŀƴ ŜŘƎŜΣ ǎƪŜǘŎƘ ǇƻƛƴǘΣ ƻǊ ŀȄƛǎΦ ¢ƘŜ ǊŜŘ ŀƴŎƘƻǊ ǿƛƭƭ ǎƴŀǇ ǘƻ ǘƘŜ ƴƻǘŜΩǎ ŀƴŎƘƻǊ ƭƻŎŀǘƛƻƴ ǘƘŀǘ ƛǎ ŎƭƻǎŜǎǘ ǘƻ 
the drag point. The Anchor position updates in the Position group of the Properties panel as you move 
the anchor to a new location. 

 
In the Cross Section tool, select the Create Offset Sections checkbox from the Options panel to create an 
offset section. Once you creŀǘŜ ŀƴ ƻŦŦǎŜǘ ǎŜŎǘƛƻƴΣ ȅƻǳ Ŏŀƴ ŎƭƛŎƪ ǘƘŜ ǎŜŎǘƛƻƴΩǎ ŎǊƻǎǎ-section indicator and 
then right-click and choose Flip Viewing Direction to reverse the direction of the section, as well as the 
orientation arrows. This option toggles so you can adjust the direction of the offset section as needed.  
 
When you select and drag an individual section line segment, the segment you are dragging will snap to 
and merge with other sections as it moves across other segments on the drawing sheet.  
 
You can now create an offset section from inside the tool. To view the cross-section cut indicator (red 
diamond), select the Cut Existing Sections tool guide, then click a section line.  
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To create a cross-section from inside the tool, click the Cross Section tool, and then within the drawing 
sheet, select a view. Use the Select Reference Geometry Inside Drawing View tool guide to place the 
section line. 
 
You can only divide a section on segments that are perpendicular to the principal direction; at your 
cursor location you can right-click on a section line segment and select Split Section. This RMB option is 
no longer available for segments that are parallel to the section direction.  
 
To view a dotted-line preview of the principal direction of a cross section, scroll with the mouse wheel 
onto the entire section line.  
 
 
 
You can now drag a Hole Table origin. To view the origin, hover over the two perpendicular axes for the 
X and Y coordinates (with extension lines). As shown in the image below, an origin displays as a red 
circle (ISO style axis circle terminator) at this juncture:   

 
When you select the origin, its size increases and all valid origin positions display as red origin points. 
These origin points remain visible until you begin to drag the origin to a different position. As you drag 
the origin, the X and/or Y coordinates data in the Hole Table immediately updates to provide a preview 
of X and Y coordinates data for the various origin positions. When you release the origin to set the new 
location, the origin points no longer display, and the Hole Table updates to reflect the X and Y 
coordinate position of the new origin location. When moved close enough to another valid origin 
position, the X and Y coordinate display in the new position, and the origin snaps to the new location. 
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You can use the Font options in the Font group of the Design tab to change the font properties of the 
X/Y labels and all hole labels, as shown in the image set below. Select and an origin axis or extension 
line, then choose your Font options. This works for hole tables that display for either single or multiple 
faces. 

 
 
 
 
It is also possible to change individual axis label font properties and/or text (text is single line). For 
example, instead of X/Y coordinates, you could have X/A coordinates, as shown in the image below. 
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Note that the table header title shows the new axis label (A). 
 
SpaceClaim uses not just one face selected to create a Hole Table but all faces of the solid with the same 
orientation to collect holes for a Hole Table. Label editing works for holes that appear on multiple faces, 
as shown in the image to the right: 
 
 

 

The Annotation group in the Detail tab has been restructured 
to include a new tool icon: Datum Target, as shown in the 
image to the right: 
 

 

 
You can now use the new   Datum Target tool in the Annotations group on the Detail tab to create a 
new datum target.   

To create a datum target 

1. Click the Datum Target tool. 

2. Hover over the planar surfaces of your model. 

An annotation plane displays. The Options-Insert Datum Target panel displays. From the panel, 
select a placement option: Point, Circular Area, Rectangular Area, Line, or Axis, as shown in the 
image below: 
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3. Click the planar surface on which you want to place the datum target point. 

4. Move your mouse to pick a location for the datum callout.  

5. Drag the callout to a location inside or outside the plane. 

When you create a datum target, by default, the datum callout height ratio is 3.5. This setting controls 
how many times the current text height the callout circle size should be, for example, the setting of 3.5x 
is for ASME, and ISO and ISO-based models use a 4x setting.  
 
You can change default settings for datum callouts and targets from the Annotation group in General 
SpaceClaim Options. Select the Show datum target end points checkbox to control 
whether or not datum target lines should show their end points. In the Linestyle options 
group, on the same page, you can choose the linestyle settings for datum target area 
borders and lines.  
 
The top field of a datum target is the dimension (target area size, or, the diameter of the 
datum target point); the bottom field is the reference letter (target identifying letter), as 
shown in the image to the right: 
 
You can use a separate callout (line, or leader) to refer to one or both text fields. Leaders are attached to 
their respective targets, i.e., when the target moves, the leader follows. Callouts can appear inside or 
outside a target. If a callout reference text is outside a target, a small circle displays by default. You can 
create multiple callouts for a datum target. To create a new callout for an existing datum target, select 
the datum target and drag the new callout to its location.  
 
To edit a datum target callout, double-click the callout. Use the mini toolbar to make your changes: 
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Lƴ ǘƘŜ tǊƻǇŜǊǘƛŜǎ ǇŀƴŜƭΣ ȅƻǳ Ŏŀƴ ŎƘŀƴƎŜ ǘƘŜ ŘŀǘǳƳ ŎŀƭƭƻǳǘΩǎ ǇŀǊŀƳŜǘŜǊǎΦ ¦ǎŜ ǘƘŜ Move tool to reposition 
a target.  

 
 
You can now view diameter, radial and angular dimension 

information for a  Bolt Circle. Create a circular pattern, and then 
click Bolt Circle in the Annotation group on the Detail tab.  
 
To activate the Annotation plane, select the face that holds the 
pattern member. Select the pattern member for SpaceClaim to 
automatically add dimension callouts, arrows and lines to the 
annotation plane. You can click on an arrow or line to view or 
ƳƻŘƛŦȅ ŜŀŎƘ ŘƛƳŜƴǎƛƻƴΩǎ ǾŀƭǳŜǎ ƛƴ ǘƘŜ tǊƻǇŜǊǘƛŜǎ ǇŀƴŜƭΦ ¢ƘŜ ƛƳŀƎŜ 
to the right shows a bolt circle with dimension callouts, arrows, 
and lines. 
 
 
 
 
When you create a drawing sheet from a document which has a design model with dimensions, you can 
RMB click on the annotation plane in the drawing sheet and select from the following options: Show 
Notes, Show all Dimensions, or Show Dimensions. These options are available when making a new 
drawing sheet from the design or when adding a view of an external design model to a new blank 
drawing sheet.  

 
The Bolt Hole Circle tool now inserts relevant angular dimensions to a hole pattern. Previously, only the 
diameter of the circle pattern and the diameter and count of the patterned holes were present on the 
annotation plane.

 
The dimensions made for Bolt Hole Circles, specifically the count for the pattern and the angular 
dimension are made separately. This means that you may delete dimensions individually. 

 
In Hole Tables, holes with counterbore, countersink, or fillets at their tops are now shown in the hole 
table and dimensions are taken from their intersection with the top plane about the cylindrical hole. 
Previously, the hole table tool did not recognize these aspects of the holes to document them in the 
hole table. 

 
There have been several updates to Datum Targets and Callouts: 
 
There are five new detail settings that control the following:  

¶ Datum Callout text height ratio ς this controls how many times larger the callout circle should be 

compared to the text height.  
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¶ Datum Target default point size ς this controls the default datum target point size used by datum 

target points, datum target lines, and datum target circles. This default can be optionally overridden 

on a per object basis 

¶ Datum Target area default hatch spacing ς this controls the hatch spacing for circular and 

rectangular datum targets. This default can be optionally overridden on a per object basis. 

¶ Datum Target area default hatch angle ς this controls the hatch angle for circular and rectangular 

datum targets. This default can be optionally overridden on a per object basis. 

¶ Datum callout leader arrow shape ς this controls the arrow shape of leaders connected to datum 

targets.  

 
The connection point for callout leaders used to run through the target and hatch area because the 
connect point was placed in the center. This was incorrect in terms of drawing standards. Now the 
virtual point is still placed in the center but instead of the line going through the target or hatch area, it 
is now clipped at the boundary of the target or hatch area. See example to the right. 

 
The Datum callout size can now be changed from the font size drop down menu. Select the Datum 
Target then choose a different font size in the drop down 
menu in the Font group on the Detail tab. 

 
You can now move all types of Datum Targets with the Move 
tool. Any dimensions applied to the datum target will update 
with the movement. 

 
Datum Target axes can be translated along a cylinder or cone axis and rotated with a special move 
handle which displays only one direction handle and one rotational handle. 

 

 
You can now click on a Datum Target line to display the length in the Properties Panel. 

 
You can now override some settings on a per occurrence basis. Per occurrence basis means that you can 
change the datum targets properties one by one after creation.  The settings which can be overridden 
are Hatch Angle, Hatch Spacing, and Point Size. Each of these can be overridden by changing the value in 
the properties menu after creating the Datum Target.  

 
There are now status messages for the Datum Targets tool to help guide the user.  

 
Datum Target lines and Datum Target axes now have the same Show Point property behavior in the 
properties panel. 
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A Datum Target circular area shows a diameter and a Datum Target rectangular area shows an area 
dimension value. However, the size information for Point Targets is suppressed by default. There is no 
area value for a point, therefore, there is no value attached to the target point. 

 
Datum Targets and Callouts only appear in the root document in the current design window. If you have 
multiple objects of the same component, any changes made to one component will be reflected in the 
rest of them. Datum Targets and Callouts only appear in the root document because if they appeared in 
all of the components, there would be multiple of the same callout when it is not needed or called for. 
This also enables you to start fresh when dimensioning in a new design window. If you do not want the 
dimensions previously applied the design in the current document, they will not follow along when 
opening this design in a new document. 
For example, if you have a table with 4 legs, each of these legs are the same component; however you 
may want to place different datum targets on each of the 4 legs, or 3 out of 4, 2 out of 4 etc. Since the 
Datum targets only appear in the root document, you can place different datum targets describing 
different features for each leg on an individual basis even though they are all the same component. See 
example image below. 
 

 
 
Datum Targets can be dimensioned in the following ways: 
 

¶ You can dimension to or from the circular area of a datum. You can also dimension to or from the 

center of a rectangular area datum or from any of its edges. 

¶ You can dimension to the end points of a datum target line or click the line itself to dimension to 

entire line. 

¶ You can dimension the whole datum target axis by clicking on the circular line. You can also 

dimension from each point of the datum target axis. 

 
Pasting notes has been enhanced to resemble functionality in MS PowerPoint. If pasting a note on the 
same page, the note will be pasted slightly below and to the right of the original note. If you are pasting 
a note from one page to another it will paste in the same position on the new page as it was placed on 
the original page. The note will never be placed by the cursor position. If for some reason you are 
zoomed in on a particular part of a drawing sheet, the note will be pasted in the middle of the view. If 
there is already a note there, it will paste slightly lower and to the right.  
 
When you add Bolt Hole Circle dimensions to a non-periodic circular pattern, the number of gap angles 
is now displayed correctly. Previously, that value reflected the number of features in the circular 
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pattern. See an example of the differences in the image to the right. 

 
 

There is now an option in the context menu called Show Bend Dimensions on an unfolded Sheet Metal 
view in a drawing sheet. Once this option is enabled, any changes made to the model will automatically 
update these bend dimensions in the drawing sheet. The Bend Dimensions layer must be turned on to 
see this. 

 
While dragging an individual planar section line segment for a Cross Section view, the preview shows the 
cross sections faces and edges in the Cross Section view preview but does not show the cross hatching 
lines that are displayed once you complete the placement of the Cross Section view. This allows for a 
faster preview display while dragging. This faster preview has now been enabled for dragging offset 
section line segments. Previously, in offset cross section previews, the hatching was shown, which made 
the preview while dragging very slow. The example below shows the differences in behavior for cross 
section display while dragging the offset section line segment. 

 
 
 

 
You can now drag slanted section line segments in an offset cross section view. Previously, only 
horizontal and vertical lines could be dragged. The image at right shows the effect of slanted cross-
section end segments ς a slanted (auxiliary) cross-section. 
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To make an offset cross section view with slanted segments: 

1. Sketch some lines in the drawing view 
2. Select on a single line  
3. Click the Cross Section tool 
4. Place the new cross section view with slanted lines 

 

Alternative workflow: 

1. Sketch some lines on the drawing sheet 
2. Select a single line and the view you want to use 
3. Click on the Cross Section tool 
4. Drag out a new cross section view with slanted lines 

 
 
You can now copy a note and then paste it in the same annotation plane before creating any geometry 
in the design window. Previously, the paste button was not active right away and you had to select on 
the annotation plane to make the paste button active. Notes can only be pasted onto datum planes or 
drawing sheets.  

 
Notes which are copied and pasted by CTRL+ dragging the note now retain their user-set anchor 
position. Previously, if the user changed the anchor position to something other than the default, the 
new note would revert to the default anchor position.  

 
You can create a Detail View that intersects multiple parts in an assembly, which then takes all the 
different body colors into account when assigning a certain color to the clip view edge.  If only one solid 
is being cut by the detail view, then the clipped edge is the color of the body. If there are multiple bodies 
being cut by the detail view, then since it is undetermined as to which body color to use for the clipped 
edge, we default to Black. 
This linestyle color can be set to a different color if needed.  There is now a Color setting for Detail view 
clipping edges in the Linestyle section of the Detailing options. This setting applies to Wireframe and 
Hidden line graphics modes on solid models; and, these settings will not work for clipping a view of a 
surface.  See example below, and note the different colors for all the separate components intersected 
by the circular detail view boundary, and that the boundary is black.  
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The Show Notes command in the RMB context menu has been implemented. When you create notes in 
a design, then create a new drawing sheet, the datum planes appear but they are empty. RMB-click on 
the datum plane and select the Show Notes option to see the notes made on the datum plane. Notes 
will only show on the particular plane you select, and will not automatically show up in the other views 
planes. 

 
 
You can now create multiple ordinate dimension sets from the same baseline edge. The baseline edge is 
the one that is assigned the 0 dimension.  Previously, if you clicked on an edge that had already been 
used as a baseline, additional dimensions would appear (according to the behavior in the standard ς 
either aligned or not with the rest) in the same baseline set.  Now, a new set of ordinate dimensions can 
be made, and this is useful when there are features of interest on both sides of a part and crossing the 
dimension lines across the part would make for an unreadable or unnecessarily cluttered view. See 
example below.  

 
 

You can now create Ordinate Dimensions from a non-linear reference. You will first need to establish a 
simple, oriented dimension, whose witness line, sets both the baseline and the orientation for the 
Ordinate Dimensions. See example to the right, where the left-most witness line of the existing circle-
circle dimension was selected in the Ordinate Dimension tool, to make the baseline for the dimension 
set along the top of the view.  
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When a note is selected in edit mode (its selection box is dashed dark blue lines), pressing Ctrl+A selects 
all the text within the note. When a note is selected in drag mode (its selection box is solid cyan lines,) 
pressing Ctrl+A selects all note fields in the design window. Previously, pressing Ctrl+A with a note 
selected in drag mode did not select all other note fields, because it incorrectly set its context for 
operating. 
 
 

Display  
 
You can now use the Clip with Plane feature to select up to 10 planes to set a clipping volume. 
Previously, Clip with Plane was limited to selecting one plane. Planes selected for clipping 
display with red boundaries. To clip with plane, select a plane and right mouse click, then 
select Clip from the Clip with Plane context menu: 
 

Clip with Plane 

 
 

 
 

Clip with Plane enables you to flip clipping direction. To enable this option, you must first lock 
the clipping direction. By default, when clipping is initially set, clipping direction is not locked, 
and the direction to clip is set automatically to clip above plane(s). If clipping direction is not 
locked, the Reverse Direction checkbox enables and is selected.  
The images below show a model with Lock Direction on, and the same model with Reverse 
Direction on:  
 

Lock Direction On Reverse 
Direction On 
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By default, when clipping is initially set, selected planes ŀǳǘƻƳŀǘƛŎŀƭƭȅ ŎƻƳōƛƴŜ ǳǎƛƴƎ ŀƴ άŀƴŘέ 
operation. This way you can isolate the inside of two parallel planes or the inside of 3 pairs of 
parallel planes (these are the most common usages.). 
 

Clipping multiple planes to isolate an area 

 
Selecting multiple ǇƭŀƴŜǎ ŦƻǊ ŎƭƛǇǇƛƴƎ ŀŘŘǎ ǘƘŜƳ ǘƻ ŀƴ ΨƻǊΩ ǎŜǘΦ ²ƛǘƘ ŀ ƎǊƻǳǇ όн ƻǊ ƳƻǊŜύ ƻŦ 
planes, you can also right mouse click, then select Unite from the Clip with Plane context 
ƳŜƴǳΦ ¢Ƙƛǎ ƻǇǘƛƻƴ ƛǎ ŜǎǎŜƴǘƛŀƭƭȅ ŀƴ άƻǊέ ƻǇŜǊŀǘƛƻƴ ǘƘŀǘ ŘŜŦƛƴŜǎ ŀ ǇƭŀƴŜ ƎǊƻǳǇ ǘƘŀǘ ȅƻǳ ƛƴǘŜnd 
to combine with the rest of the planes. Once you define and unite a group of planes, the 
United set is put at the beginning of the logical set, and the rest of the planes follow with their 
ŘŜŦŀǳƭǘ άŀƴŘέ ǎǘŀǘŜǎΦ  
For example, you can select 3 planes and get these logical sets, as shown in the table of 
images below: 

¶ A and B and C, which is the default (showing 1/8 of the model) 

¶ (A or B) and C, where A and B are united (showing 3/8 of the model) 

¶ (A or C) and B, where A and C are united (showing a different 3/8 of the model) 

¶ (B or C) and A, where B and C are united (showing a different 3/8 of the model) 

¶ A or B or C, where A and B and C are united (showing 7/8 of the model) 
 
 
A and B and C, which is the default (1/8) (A or B) and C, where A and B are united (3/8) 

  
(A or C) and B, where A and C are united (3/8) (B or C) and A, where B and C are united (3/8) 
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A or B or C, where A and B and C are united (7/8)  

 

 

You can also define clipping volume by: 

¶ Some number of planes selected together 

¶ Pairs of ǇƭŀƴŜǎ ǳǎŜŘ ƛƴ άƻǊέ ƎǊƻǳǇ ό¦ƴƛǘŜύ 

¶ Clip direction  
The number of all possible clipping volumes (or states) depends on the number of planes 
selected and clip options (lock/inverse/unite.) set on each one and on any selected pairs. The 
image below shows the results of uniting two planes, A and B: You can see that sets of parallel 
planes default to keeping the material inside them. 
 
Before Planes Unite (Unite 
off)  

After Planes Unite 
(Unite on)  

 
 

 
You can now set a clip face color as a global display option. In the General section of Appearance 
SpaceClaim Options, select a Custom, Web, or System color, and click OK.  
When you set a clip face color, the color you choose: 

¶ Changes the Section mode cut face color, unless it is invoked when you use the Plane tool, or if 
you use another Color tool or Style Override to change the color 

¶ Is not saved with the model, since it applies to all documents used in that session 

If you set a clip face color from the Properties panel, the setting is stored in the document.  

 
The Exclude from Planar Clipping function allows you to exclude components from the Clipping 
operation, so you can colorize clipped faces for an enhanced model display, as shown in the orange 
color in the image. With a component selected in either the Structure tree or the Design window, right-
mouse click and choose Exclude from Planar Clipping > Set. Once you set this option, that sub-assembly 
is not cut with any specified Clipping Planes (see the central shaft and gears that have no orange in the 
picture at right). To remove the setting, right-mouse click and choose Exclude from Planar Clipping > 
Clear. 
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Now, you can select the visible plane you want to clip, then right-click anywhere in the Design window 
or the Structure tree to display the Clip with Plane context menu. 

 
 

You can now change the transparency of the inside of individual datum planes. Setting a different 
transparency can help you identify different planes and see their intersection with the model more 
ŜŀǎƛƭȅΣ ǿƘƛƭŜ ōŀƭŀƴŎƛƴƎ ǘƘŜ ΨǿŀǎƘŜŘ-ƻǳǘΩ ŜŦŦŜŎǘ ƻƴ ǘƘŜ ǊŜǎǘ of the geometry as seen behind the plane. 
After you create a datum plane, select Transparent from the mini-toolbar. To change the transparency, 
select Color from the mini-toolbar, and move the Opacity slider.  

 
While using the Clip with Plane tool for graphics clipping, when you select ClipΣ ǘƘŜ ǇƭŀƴŜΩǎ ƛƴǘŜǊƛƻǊ ƴƻǿ 
changes to transparent, which allows for enhanced usability. Also with Clip with Plane, you can now click 
the Undo and Redo tools in the Quick Access toolbar or press Ctrl+Z to undo and Ctrl+Y to redo. 

 
There is now an icon of a broken brick on the gray background when you encounter a graphics crash. 
See example below: 

 

 
There is now an option to set the default layer color when creating new documents in the General 
section of the Appearance SpaceClaim Options. You will find this option in between the y-axis and the 
ruler dimensions.  

 
The Clip with Plane feature allows planes to exist in 3 different states: Clip, Reverse Direction, or Union. 
This feature has been enhanced so that now, when you save a model with clipped planes, and you are 
working with the model in various clipped plane states in two or more design window panes, the clip 
state of each plane in the model is saved per window with the model.  As you move between window 
panes, the Structure tree updates to reflect the clip state of each plane in the active window context.  
The image set below shows two window panes and their associated Structure trees: 
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The face color of a part, such as a body, now dims correctly if the part is inactive. Once the part is 
selected and thus becomes active, the face color no longer displays as dimmed.  

 
Now, when working with Clip with Plane, the portion of the model that is between the plane and the 
viewpoint of the user, is the portion that is removed.  This way the back side of the model is always 
shown first.   

 
When you use the Thread tool in the Annotation group on 
the Detail tab to create a threaded surface, the threads 
(either inner or outer) now display as spirals. Previously, 
threads displayed as rings, not spirals. The image set to the 
right shows examples of threaded surfaces: 
 
 
 
 

 
 
There are now options for a Plane in the Properties panel named Fill and Outline which change the 
appearance of a plane. The defaults for both options are set to Automatic. The other options are No Fill 
and No Outline. When Fill is set to automatic, the geometry behind the plane looks lighter than any 
geometry that is not under the plane in that view state. If you set the Fill option to No Fill then all the 
geometry under and outside of the plane view will be the same opacity. A plane which has annotations 
can be set to a No Fill state but will not show a difference in opacity because the plane becomes 
completely transparent once any annotations are made. When the Outline is set to automatic, you will 
see the light blue outline of the plane. When the Outline is set to No Outline, then the outline is invisible 
unless the plane is selected. Setting planes to a No Fill and/or No Outline state are useful when 
dimensioning parts; it is easier to see annotations when the planes are less visible. Below are examples  
of the planes in different states.  


















































